
Section 3

Deathmatch Maker Interface
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n Deathmatch Maker, you’ll use three windows and two Tools Pads as
you create Quake levels: Gallery Window, Walk Window, Design

Window, Design Window Tools Pad, and Surface Editor Tools Pad. Below are
descriptions of these. Take a moment and open Deathmatch Maker so you can
view its parts as we provide descriptions.

WINDOWSWINDOWSWINDOWSWINDOWSWINDOWS

When Deathmatch Maker opens, you’ll see three windows. At the left, the
Gallery Window displays the galleries used in building levels. At the top-right,
the Design Window displays the Top View, one of that window’s three views
in which you can edit some three-dimensional objects. (The other two Design
Window's views are Front and Right.) Below the Design Window is the Walk
Window, an empty window with a dark gray background. As you add objects
to your level in the Design Window, the Walk Window will show you a three-
dimensional drawing of them.

The Gallery Window is always
active, and you can activate ei-
ther the Design Window or the
Walk Window. Activating a win-
dow means that you can select
objects and press buttons for
that window. You make a win-
dow active by clicking anywhere
in or on it. An active window
displays a highlighted title bar.
If a window is not active, its
buttons and tools are shaded
and not selectable. If the De-
sign Window is not active, the
Design Window Tools Pad is
not visible.

BUTTONS, NAVIGATIONBUTTONS, NAVIGATIONBUTTONS, NAVIGATIONBUTTONS, NAVIGATIONBUTTONS, NAVIGATION

Movement in the Walk Window is accomplished by using the standard Virtus
navigation cursor techniques or the Navigation buttons along the bottom of the
Walk Window.

NOVICE NAVIGATION BUTTONS
The Navigation buttons are always active when the Walk Window is active. Click
on one of the Navigation buttons to move in that direction. If you hold down the
mouse button while pointing to a navigation button, you move continuously.
From left to right along the bottom of the Walk Window, the Navigation
buttons are Move Forward, Move Backward, Turn Left, Turn Right, Move Up,
and Move Down.

Gallery
Window

Design Window

Walk Window

I
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The Walk Mode buttons are displayed to the left and to the right of the Novice
Navigation buttons along the bottom of the Walk Window. The Walk Mode
buttons determine what happens when you click with the mouse cursor in the
Walk Window.
The Walk Mode buttons from left to right are Walk, 3-D Select Surface, 3-D
Select Object, Auto Texture, Level Observer, and Home. Only one Walk Mode
button can be selected at any time.

WALK BUTTON
The Walk Button allows you to “walk through” the Walk Window
by positioning the cursor around the cross hair.

3-D SURFACE SELECTOR BUTTON
The 3-D Surface Selector Button allows you to quickly choose a
surface in the Walk Window to edit; you can change the surface’s

texture or add surface features such as door or window openings.

3-D SELECT OBJECT BUTTON
The 3-D Select Object Button allows you to select an object in the
Walk Window and have it highlighted and centered so that you can

edit it in the Design Window. This is extremely useful when you are working
on a complex design and cannot select the correct object in the Design

After selecting
the 3-D Surface
Selector Button
and clicking on
a surface, it is
displayed in
the Surface
Editor. Now,
the texture of
the surface can
be changed or
added.

Move       Move                 Turn Left          Turn Right        Rise Up           Sink Down
Forward       Backward
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Window because another object is blocking it. (Another way around this is to
change views, select the object, and return to the Top View to move or edit the
object.)

Note: If you use either the Select Surface Button, Select Object Button, or the
Auto Texture Button, you need to select the Walk Button to enable navigation
(walking) again.

AUTO TEXTURE BUTTON
With the Auto Texture Button, you can apply a selected texture to
any surface you click on.

LEVEL OBSERVER BUTTON
With the Level Observer Button, you orient the Observer’s level of
sight in the Walk Window, making it level if it has been altered

by the Shift key while you were navigating.

HOME BUTTON
Home Button allows you to return your position in the virtual
environment to the 0,0,52.5 Quake units coordinate (at about

eye level).

COORDINATESCOORDINATESCOORDINATESCOORDINATESCOORDINATES

Coordinates pinpoint the location of objects on your screen. In the Top View
of Deathmatch Maker, X represents the horizontal units of measure on the
screen (from left to right). Y represents the vertical units (from bottom to top).
When you switch to the Front View, X still represents the horizontal units of
measure and Z represents the vertical units. Finally, when you switch to the

Right View, Y represents the horizon-
tal units of measure and Z represents
the vertical units.
For example, coordinates -50,200 in
the Top View translates to -50 Quake
units on the X axis and 200 Quake
units on the Y axis. In the Front View,
you’ll see that -50,200 again trans-
lates to -50 Quake units on the X axis,
with 200 Quake units represented on
the Z axis. And in the Right View, -
50,200 translates to -50 Quake units
on the Y axis, with 200 Quake units
represented on the Z axis.
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DEPTH CONTROL GAUGESDEPTH CONTROL GAUGESDEPTH CONTROL GAUGESDEPTH CONTROL GAUGESDEPTH CONTROL GAUGES

A Depth Control Gauge appears on each ruler in the Design Window and on the
ruler in the Depth Window. Depth Control gauges determine the inflation
distance and position of objects. Because there are three dimensions in
Deathmatch Maker, there are three Depth Control gauges that determine
inflation distance and position in the X, Y, and Z dimensions. By reading the
letter in the Dock on each ruler, you can determine which dimension each
Depth Control Gauge is associated with.
A Depth Control Gauge consists of two black half-arrowheads on each end of
a gray bar. The half-arrowheads are called endpoints. The distance between
the endpoints is the inflation distance, or the depth. The object position is
determined by where the endpoints are in space. The endpoints determine
where the object begins or ends.
Endpoints can be dragged to a new location, thus stretching or compressing
the gray bar, or the entire Depth Control Gauge can be moved by dragging the
gray bar.

HANDLESHANDLESHANDLESHANDLESHANDLES

In Deathmatch Maker, one of four types of handles appears when you click on
an object. The specific type of handle gives you information about how the
selected object can be edited or manipulated. The handle types are:

Black Handles: Black handles can be manipulated in any direction to
change the object’s shape. When you’re in the Top View, all objects from
the Basic Shapes 3-D Gallery show black handles when the objects are
selected (In the Front and Right views, white handles are shown).

Gray Handles: Grouped objects (two or more objects selected and joined
with the Group command in the Design menu) show gray handles when
selected. Grouped objects first must be ungrouped (with the Ungroup
command in the Design menu) before these objects can be manipulated.

Alley

Inflation Distance

Movable Origin

Dock

Depth Control Gauge
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White Handles: A selected object showing white handles tells you that
only the depth of the object can be manipulated. (You adjusted the depth
of the rectangle while in the Front View by moving the top edge of the
rectangle from 8 to 15 Quake units.)

Red Handles: Rigid objects have red handles indicated that they cannot
be resized or rotated, and the Object Property class cannot be changed.

MEMORY INDICATORMEMORY INDICATORMEMORY INDICATORMEMORY INDICATORMEMORY INDICATOR

The memory indicator is to the right of the message bar, at the lower-right
corner of the Deathmatch Maker Window. It contains a colored bar that shrinks
and grows, displaying the amount of memory currently available to Deathmatch
Maker. The longer the bar, the greater the amount of memory being used by
Deathmatch Maker. If free memory is less than 25 percent, the meter turns red.
To learn more about memory and memory management, please refer to your
computer and operating system documentation.

OBSERVEROBSERVEROBSERVEROBSERVEROBSERVER

In the Design Window, the Observer is a circle with a line extending from its
center; it represents where you’re standing in the virtual world. The tip of the
line (outside the circle) points in the direction in which you’re looking while in
your level’s Walk Window. When you start Deathmatch Maker, the Observer
is positioned at coordinate 0,0.

SURFACE EDITORSURFACE EDITORSURFACE EDITORSURFACE EDITORSURFACE EDITOR

The Surface Editor appears in the Design Window when a surface
is selected. It allows you to edit the selected surface. Notice the

O, I, and B buttons at the bottom-left of the view. These are Placement buttons.
O is the outside surface, I is the inside surface, and B is both the inside and
the outside surfaces. Select a button to determine which side of the surface
the texture or surface feature is applied to.

SURFACE GALLERIESSURFACE GALLERIESSURFACE GALLERIESSURFACE GALLERIESSURFACE GALLERIES

When the Surface Editor is open, the Gallery Window changes to show the
Basic 2-D Gallery, a collection of surface features. A surface feature, like an
object, can be dragged from the gallery and dropped into the Surface Editor
onto a selected surface. Once dropped, you can rotate a surface feature with
the Rotate Object Tool and scale it with the Resize Object Tool. You can apply
textures from the Texture Gallery to the surface.

TOOLS PAD, DESIGN WINDOWTOOLS PAD, DESIGN WINDOWTOOLS PAD, DESIGN WINDOWTOOLS PAD, DESIGN WINDOWTOOLS PAD, DESIGN WINDOW

When you open Deathmatch Maker, the Design Window Tools Pad displays
the tools you use to edit objects. Below is a description of its tools and how
they function.

Placement
Buttons
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ZOOM-OUT TOOL
The Zoom-Out Tool decreases the apparent scale of the Design
Window. Select the Zoom-Out Tool by clicking on it, point to the area
that you want to zoom away from, and click to decrease the apparent

scale of the Design Window by a factor of two.

ZOOM-IN TOOL
The Zoom-In Tool increases the apparent scale of the Design Win-
dow. Select the Zoom-In Tool by clicking on it, point to the area that
you want to zoom toward, and click to double the apparent scale of

the Design Window.

SELECT OBJECT TOOL
The Select Object Tool selects entire objects to be edited. Click on an
object to select it. A selected object displays handles at its vertices.
A vertex is where two object surfaces, or faces, meet. A selected

object with handles and a dot-fill pattern is illustrated to the right.

LOCK OBJECT TOOL
The Lock Object Tool functions in the Design Window and in the
Surface Editor. It allows you to lock objects or surface features so
they cannot be edited. A locked object is visible in the Design

Window but cannot be selected or changed until it is unlocked. To do so, select
Unlock All from the Edit menu.

HIDE OBJECT TOOL
The Hide Object Tool functions in the Design Window and in the
Surface Editor and allows you to hide objects or surface features in
the Design Window, the Walk Window, or both. Hidden objects and

surface features are not visible in the Design Window but are still a part of your
level. They can be seen in the Walk Window. To make them visible again in the
Design Window, choose Show All from the Edit menu.

RESIZE OBJECT TOOL
The Resize Object Tool scales an object about its center or about a
specified anchor point. Objects can only be resized using this tool.
Objects are resized uniformly along all three axes or non-uniformly

along a single axis.

SKEW OBJECT TOOL
The Skew Object Tool distorts an object from its true symmetrical
form, taking the object out of plumb. An object can be skewed on
more than one axis but only from the view in which it was created.

A selected
object displays
handles (black

squares)
at its vertices.
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CREATE RECTANGULAR OBJECT TOOL
The Create Rectangular Object Tool draws a rectangle.

CREATE IRREGULAR OBJECT TOOL
The Create Irregular Object Tool draws an irregular-shaped object,
one segment at a time. This tool does not draw non-convex objects
or surface features.

CONNECT SURFACES TOOL
The Connect Surfaces Tool functions in the Design Window and is
used to connect two objects together at a common surface. A
connection between surfaces is necessary to see any common

surface features such as the transparent surface features representing door-
ways or windows. Without the connection, surface features between objects
are not shared and holes do not penetrate both surfaces.

Note: Surface features between objects are not shared, and holes do not
penetrate both surfaces unless a connection is made with the Connect
Surfaces Tool.

The Connect surfaces Tool only works on objects that are not grouped. To
connect grouped objects, you must precisely align the walls that are to be
connected, ungroup the objects to be connected, and use the Connect Surfaces
Tool. Be VERY careful to not move any of the objects to be connected. If you
do, connecting them will be very difficult because earlier connections will be
broken by the later connections. Hint: Use the Zoom-In Tool on the Tools Pad
when creating grouped objects or while connecting grouped objects. It will
help you see the working surfaces more closely.

ROTATE OBJECT TOOL
The Rotate Object Tool is used to rotate an object. This tool works in
any view (Top, Front, and Right), allowing rotation around more than
one axis.

SURFACE EDITOR TOOL
When you press the 3-D Surface Selector Button and select a
surface to edit in Deathmatch Maker’s Design Window, the

Surface Editor appears and the Surface Editor Tools Pad replaces the Design
Window Tools Pad. (Notice the O, I, and B buttons at the bottom-left of the
Walk Window. These are Placement buttons. O is the outside surface, I is the
inside surface, and B is both the inside and the outside surfaces.) The selected
button determines where the texture or surface feature is applied to the
surface.
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 TOOLS PAD, SURFACE EDITOR TOOLS PAD, SURFACE EDITOR TOOLS PAD, SURFACE EDITOR TOOLS PAD, SURFACE EDITOR TOOLS PAD, SURFACE EDITOR

The Surface Editor Tools Pad displays the tools you use to edit surfaces of
objects. The Surface Editor Tools Pad has many of the same tools as the Design
Window Tools Pad and a few others. The tools exclusive to the Surface Editor
are the Return Button, Add/Remove Handle Tool, and Opacity Modifier Tools.

RETURN BUTTON
The Return Button closes the Surface Editor and returns you
to the Design Window.

ADD/REMOVE HANDLE TOOL
The Add/Remove Handle Tool lets you add a new handle to a surface
feature or remove an existing handle. A handle represents the vertex
(the meeting of two object surfaces.

OPACITY MODIFIER TOOLS
The Opacity Modifier Tools can be used to change the opacity
of an object to opaque or transparent. The Make Opaque
Button is on the left; the Make Transparent Button is on the
right.

WINDOW, DESIGNWINDOW, DESIGNWINDOW, DESIGNWINDOW, DESIGNWINDOW, DESIGN

The Design Window offers two ways to see your 3-D objects:

1. Choosing a Top, Front, or Right view allows you to edit 3-D objects
(ammo, weapons, and so forth).

2. Activating the Surface Editor Tool allows you to edit 2-D surfaces
(windows, doors, and so forth). The window’s title bar includes the
word Surface:, and a 2-D gallery appears on your screen.

WINDOW, WALKWINDOW, WALKWINDOW, WALKWINDOW, WALKWINDOW, WALK

The Walk Window displays a three-dimensional drawing of the two-dimen-
sional items that you place in the Design Window. In this window, you can
navigate through (walk through) your model.

WINDOW, GALLERYWINDOW, GALLERYWINDOW, GALLERYWINDOW, GALLERYWINDOW, GALLERY

Displays a collection of either two- or three-dimensional objects or  textures,
depending on whether you’ve chosen to work with a 2-D gallery or a 3-D
gallery. Any object in a gallery can be dragged and dropped into the Design
Window and edited.
When you right-click on an object in the Design Window, the Object Properties
Dialog appears. Under the Object Tab is an entry called Class. When you scroll
this list, you will see all the Quake classes.
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MENUSMENUSMENUSMENUSMENUS

Menus allow you to display Deathmatch Maker commands. Some are typical
Windows 95 menus you are familiar with and others are unique to Deathmatch
Maker. This chapter lists them and describes them for you.

FILE MENUFILE MENUFILE MENUFILE MENUFILE MENU

COMMAND PURPOSE

New creates and opens a new Deathmatch Maker file.
Open… displays the Open dialog from which you can select a

file to open.
Close closes the current file. If you made any changes to the

file since the last time you saved it, you are prompted
to save the changes before the file is closed.

Save saves the current file under the currently used name or
prompts you for a name if untitled.

Save As… opens the Save As… dialog, which allows you to save
the current file under a new name.

World Info allows you to set the title of the level, its type, the CD track
to play for this level, and the light intensity for the level.

Quake Import allows you to import Quake .map files (*.map).
Quake Export allows export of .map files and creation of .bsp file with

lighting and visibility so your level can be played in
Quake.

Exit exits Deathmatch Maker. If a file is open and changes
were made since the last time it was saved, you are
prompted to save any changes before exiting.

EDIT MENUEDIT MENUEDIT MENUEDIT MENUEDIT MENU

COMMAND PURPOSE

Undo undoes the last operation performed in the Design
Window.

Cut moves any selected objects to the Clipboard. Cut ob-
jects can be pasted with the Paste command.

Copy copies any selected objects to the Clipboard, leaving
the original in place. (Note that Cut moves objects to
the Clipboard and does not leave the original in place.)
Copied objects can be pasted with the Paste command.

Duplicate makes an exact copy of any selected object or surface
feature and places it on or near the original. Unlike the
Cut and the Copy commands, Duplicate does not copy
to the Clipboard.
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Duplicate duplicates objects as well as object place-
ment, scaling, and rotation. For example, you can cre-
ate an object, duplicate that object, and position the
second object on the right side of the original so that the
objects appear to be touching. Then you can select
Duplicate again and an identical third object, joined on
the right side of the second object, will appear; you’ll
have a line of three objects spaced the same distance
apart. The duplicate’s position relative to the object
that it duplicated is maintained as long as the original
object remains selected. If you continue choosing Du-
plicate, the objects will continue duplicating to the
right until you have a line of identical objects. This can
be extremely helpful in creating objects such as stair-
cases or fence posts.
Changes to Object Type are not duplicated. For ex-
ample, if you create an object 100 Quake units tall and
then duplicate it and increase the height of the duplica-
tion to 150 Quake units, subsequent duplications will
have a height of 150 Quake units—they will not grow
in height by increments of 50 Quake units.

Cool tip: If you want to accomplish the effect of an incremental increase in
size or shape, you must use the Resize Object Tool to adjust the size or shape
of the first duplication and then duplicate it.

The Duplicate command only duplicates manipulations
to the entire object. It does not duplicate changes to
part of an object.

Paste copies the contents of the Clipboard into the level.
Delete removes selected objects or  surface features without

placing them in the Clipboard. Selected objects can
also be deleted by pressing the Delete key or the
Backspace key. Delete removes objects completely,
whereas Cut moves objects to the Clipboard from
which they can be pasted back into the level.
If you Delete or Cut something accidentally and need to
reverse that action, immediately choose Undo under
the Edit menu after the cutting or clearing operation.

Select All selects all objects.
Unselect All unselects objects or surface features (handles are re-

moved). Another method of unselecting is clicking on the
background in the Design Window or Surface Editor.

Hide Selected hides selected objects and surface features. Hiding
objects or surface features allows you to work on
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surface features without having to shuffle them.
By default, hidden objects are hidden in the Design
Window and surface features are hidden in the Surface
Editor, but they remain visible in the Walk Window.

Show All displays surface features hidden in the Design Win-
dow. The Ctrl key must be held down in conjunction
with Show All to display them. If using the Ctrl key with
this command, you must select the command from the
menu; you cannot use the command key equivalent.

Lock Selected locks selected objects in the Design Window and se-
lected surface features in the Surface Editor. Locking
objects or surface features prevents them from being
edited. When an object or surface feature is locked, its
polygonal outline is solid.

Unlock All unlocks all locked objects and surface features locked
with the Lock Object Tool or with the Lock Selected
command to allow editing. You can also lock a layer,
which locks all objects on that layer.

Preferences The Preferences dialog allows you to set preferences
for Deathmatch Maker.
Each time you save a Deathmatch Maker level, any
changes that you made to the Preference settings are
saved with it. When you open the model again, its
preferences are restored.
Preferences includes three separate tab selections:
Editor, Rendering, and Navigation. Each is described
briefly below:
Editor options allow you to change preferences com-
mon to the Design Window and Surface Editor.
Navigation options allow you to change preferences
related to navigating the Observer through the Walk
Window and related to Walk Window features.
Rendering options allow you to change preferences
related to rendering in the Walk Window.
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PREFERENCES, EDITOR OPTIONS

COMMAND PURPOSE

Aids
Show Ruler if selected, displays rulers.
Show Grid if selected, displays the background grid based on

the ruler major tick marks.
Show Depth if selected, displays the Depth Control gauges on the

rulers.
Show Guides if selected, displays Non-Reproducing Guidelines.
Show Origin if selected, displays Movable Origin.
Snap to Grid if selected, snaps objects and surface features to an

invisible grid when they are created, moved, or
edited.
The grid is based on the ruler tick marks in the Design
Window and Surface Editor. Handles of objects and
surface features will “snap to” the grid when Snap to
Grid is selected.
If you zoom in or out, the ruler tick marks change,
changing the invisible grids. For example, each tick
mark represents one Quake unit, so Snap to Grid will
snap objects to the nearest Quake unit.
If Snap to Grid is not selected, the ability to create,
edit, and move objects and surface features is con-
strained only by screen pixels.
If an object, surface feature, or slice is created with
Snap to Grid unselected and then edited or moved
with Snap to Grid selected, the object or surface
feature moves in increments of the invisible grid but
doesn’t actually snap to the grid. This makes it
possible for handles to fall between the ruler tick
marks, which can be frustrating when you try to align
objects or surface features. However, if you move a
handle rather than the whole object or surface fea-
ture, the handle will snap to the grid.

Object Class if selected, displays object class in Design Window
info bar when the cursor passes over it.
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Color
Ruler lets you specify ruler color.
Grid lets you specify Grid color.
Depth lets you specify Depth Control Gauge color.
Guide lets you specify Non-Reproducing Guideline color.
Origin lets you specify Movable Origin color.
Background lets you specify background color. The background

color is the color of the drawing area in the Design
Window and Surface Editor.

PREFERENCES, RENDERING OPTIONS

COMMAND PURPOSE

Shading
Shaded displays objects with lighting effects.
Unshaded displays object colors with no lighting effects.
White displays objects with no color (white color fill) and no

lighting effects.
Drawing

Fill & Frame displays both the color fill and wire frame of objects.
Fill displays only the color fill of objects with no wire

frame.
Frame displays only the wire frame of objects.

Flash Graphics turns on Virtus Corporation drawing routines and
uses those routines instead of the standard Microsoft
Windows drawing routines. Flash Graphics substan-
tially speeds up the WalkThrough Pro application.
Flash Graphics is turned on by default; however,
some video boards are not compatible with Flash
Graphics. The Deathmatch Maker application checks
for compatibility with your system when you install,
and if a conflict is detected, Flash Graphics is turned
off.

Note: If you turn off the check box and are not experiencing difficulties with
the graphics, you will get errors when using textures and when viewing 3-D
geometries in the Walk Window.

Options
Dithering is a technique that allows more colors, thus more

color-accurate renderings. Dithering is turned on by
default. The disadvantage of dithering is that the
screen appears more grainy.
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PREFERENCES, NAVIGATION OPTIONS

COMMAND PURPOSE

Aids
Cross Hair if selected, displays a cross hair in the Walk Window

that is used as a reference point for direction and
walk through speed.

Velocity Grid if selected, displays horizontal and vertical marks at
increments relative to the cross hair where walk
speed changes.

Collision Detect if selected, the Observer can move through doors or
transparent openings on surfaces only. When the
Observer encounters a wall, it stops; a clicking sound
confirms that the Observer ran into a wall.

DESIGN MENUDESIGN MENUDESIGN MENUDESIGN MENUDESIGN MENU

COMMAND PURPOSE

Snap to Grid snaps objects and surface features to an invisible
grid when they are created, moved, or edited. The
grid is based on the ruler tick marks in the Design
Window and Surface Editor. Handles of objects and
surface features “snap to” the grid when Snap to
Grid is selected.
If you zoom in or out, the ruler tick marks change,
changing the invisible grids. For example, each tick
mark represents one Quake unit, so Snap to Grid will
snap objects to the nearest Quake unit.
If Snap to Grid is not selected, the ability to create,
edit, and move objects and surface features is con-
strained only by screen pixels.
If an object or surface feature is created with Snap to
Grid unselected and then edited or moved with Snap
to Grid selected, the object or surface feature moves
in increments of the invisible grid but doesn’t actu-
ally snap to the grid. This makes it possible for
handles to fall between the ruler tick marks, which
can be frustrating when you try to align objects or
surface features. However, if you move a handle
rather than the whole object or surface feature, the
handle will snap to the grid.
Snap to Grid can be selected and unselected under
Preferences Editor dialog and the Design menu.
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Zoom-In increases the apparent scale and size of objects in the
view by a factor of two. With each zoom in, the minor
tick marks on the rulers represent a smaller unit of
measurement. There is a limit to the range of the
Zoom-In command; when you reach the limit, select-
ing Zoom-In will have no effect.
Zooming in can also be accomplished by clicking on
the Zoom-In tool. Zoom-Out reverses the effect of
Zoom-In.

Zoom-Out reduces the apparent scale and size of objects in the
view by half. With each zoom-out, the minor tick
marks on the rulers represent a larger unit of measure-
ment. There is a limit to the range of the Zoom-Out
command; when you reach the limit, selecting Zoom-
Out will have no effect.
Zooming out can also be accomplished by clicking the
Zoom-Out Tool. Zoom-In reverses the effect of Zoom-Out.

New Layer lets you add a new layer to the Layer List. If you select
New Layer, a dialog appears with a text box in which you
can type the new layer name. This name will then appear
in the Layers Window and become the active layer.

Delete Layer deletes the selected layer in the Layer List and all the
objects that reside in that layer. If you select Delete
Layer, you are prompted to verify the deletion

Group groups all selected objects, treating them as a single
object. A grouped object can be moved, copied, and
rotated. It can only be scaled using the Scale Object
tool. It is important to group gallery items with the
Group command before copying them to a gallery.

Ungroup ungroups selected objects that were grouped with the
Group command. Once you ungroup an object, all the
objects that make up the group remain selected until
you click somewhere else inside the view. This means
that if you want to change the texture of a grouped
object, you can ungroup it, select a new texture, and
group the objects again. This only works if you want all
objects within the group to be the same texture. It’s a
good idea to group staircases before moving them.
It is possible to have groups within other groups. If you
ungroup an object but cannot edit it, try ungrouping
again.

Note: The Design menu is available only when a Design Window is active. If
the Surface Editor or Walk Window is active, the Design menu disappears.
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WINDOW MENUWINDOW MENUWINDOW MENUWINDOW MENUWINDOW MENU

COMMAND PURPOSE

Design displays or hides the Design Window.
Walk displays or hides the Walk Window.
Tools displays or hides the Tools Pad.
Layers displays or hides the Layers Window.
Tile Horizontal positions the active window on top. The Gallery Win-

dow is positioned normally, that is, to the left of the
other windows.

Tile Vertical positions the active window on the left. The Gallery
Window is positioned normally, that is, to the left of the
other windows.

QUAKE OBJECT PROPERTIES DIALOGQUAKE OBJECT PROPERTIES DIALOGQUAKE OBJECT PROPERTIES DIALOGQUAKE OBJECT PROPERTIES DIALOGQUAKE OBJECT PROPERTIES DIALOG

The Quake Object Properties Dialog allows you choose settings that affect
how your newly created level will look when exported to Quake. The settings
do not affect the appearance of your level, objects, or textures in the Design
Window or the Walk Window.
To view the Quake Object Properties Dialog as you read this section, drag and
drop Square from the Gallery Window to the Design Window. Right-click the
square to bring up the dialog.

OBJECT TABOBJECT TABOBJECT TABOBJECT TABOBJECT TAB

DIALOG BOX DESCRIPTION/
ELEMENT PURPOSE

Class A drop-down list of Quake object types. Choose
from this list to assign a class to an object. For
some classes, option buttons appear to the right of
the Class drop-down list. Use these to set specific
options for that class.

Object Name The name of this object. All named objects must
be targeted and all targets need a name to refer-
ence.

Comment A comment to be added to the .map file for read-
ability. Advanced users can read the .map file and
learn from the .map specs.

Levels Places the object into the selected skill levels. For
instance, if you have an object marked as beginner
level only, it appears only in that skill level.
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 ATTRIBUTES TAB ATTRIBUTES TAB ATTRIBUTES TAB ATTRIBUTES TAB ATTRIBUTES TAB

DIALOG BOX DESCRIPTION/
ELEMENT PURPOSE

Angle Angle in degrees an object is facing or moving in
Quake. Choosing Up or Down, if available, will
move the object in that selected direction. If Pitch,
Yaw, and Roll are available and selected, you are
specifying a three-dimensional point at which the
object is pointing.

Speed Speed an object moves.
Wait Number of seconds of wait time between comple-

tion of an event and its restart or return. For
instance, you can set the elapsed time before a
button resets or a lift returns.

Lip Object thickness. For instance, the amount an
object intrudes into space or is flush with nearby
objects, for instance, a lift or a room’s floor.

Brightness Intensity of a light.
Style A drop-down list that allows you to choose from

several types of a selected class. For example, you
can choose a Large Yellow Flame in the Object
Class, and you can define its behavior by selecting
from Flicker 1 to Slow Pulse as its style.

Health How much damage an object takes before trigger-
ing. For instance, some buttons can be triggered
by shots from Quake players. You can specify the
amount of health damage the button requires
before it triggers a targeted object.

Height Distance an object moves up or down.
Delay Elapsed time from triggering of an action to when

it starts.
Light Starts On, State of light in Quake when a player first enters
or Light Starts Off a level.
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INTERACTION TABINTERACTION TABINTERACTION TABINTERACTION TABINTERACTION TAB

DIALOG BOX DESCRIPTION/
ELEMENT PURPOSE

Target An object that activates when this object is trig-
gered. For instance, if you have an object whose
Object Name is door1, then you can create a
button that targets the door. Enter door1 in the
Target box.

Kill Kill is the same as target except that it works only
once.

Damage Amount of damage an object causes Quake play-
ers. This is reflected by a decrease in the player’s
health. Example: If a door’s Damage is set to 100,
it will kill if it shuts on a player.

Sound A drop-down list of sounds that can be specified
and linked to this object. Example: The sound a
door makes when it opens.

Message Displayed text message triggered by this object.
Example: Trigger posts a message, “This door
opens elsewhere.”

Map Name of another .bsp file. Used only for the
Trigger Change Level object. This enables you to
specify which level Quake players move to when
they exit the current level.

ADVANCED TABADVANCED TABADVANCED TABADVANCED TABADVANCED TAB

DIALOG BOX DESCRIPTION/
ELEMENT PURPOSE

Geometry Options Hollow Geometry: Expand  In Walls in Deathmatch
Maker are infinitely thin. For Quake, walls need to
have thickness. Most of the time, wall thickness is
set automatically during the Quake export. If you
test your level (made in Deathmatch Maker) in
Quake and the player falls through floors and goes
through walls, you need to use the Hollow Geom-
etry: Expand In or Hollow Geometry: Expand Out
tool on that room. This hollowing in does not
appear in the Design View but will appear in
Quake after export.
Hollow Geometry: Expand Out  Walls in
Deathmatch Maker are infinitely thin. For Quake,
walls need to have thickness. Most of the time,
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wall thickness occurs automatically during the
Quake export. If you test your level (made in
Deathmatch Maker) in Quake and the player falls
through floors and goes through walls, you need to
use the Hollow Geometry: Expand In or Hollow
Geometry: Expand Out tool on that room. This
hollowing out does not appear the Design View
but will appear in Quake after export.
Solid Geometry is a solid shape in geometry.

Custom Object If you are creating a custom object and select
has geometry Custom in the Class drop-down list under the

Quake Object Properties Dialog tab, you need to
decide if the object needs geometry shapes.


